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ArcGIS Schematics SDK Quick-Start Tutorial 

ESRI® ArcGIS™ Schematics SDK is a Windows®-based solution that meets network managers' needs for graphically 
visualizing and manipulating their network data. This software solution can be integrated in all compatible Microsoft® 
COM development environments. 

ArcGIS Schematics SDK delivers powerful tools that let you automatically generate a graphic representation of your 
network using its associated database information. You can analyze networks in geographical, geoschematic, and 
schematic layouts. It is also a high-end development platform that you can use to rapidly build a variety of graphic 
custom applications for your network information system. With its advanced functionality, network graphs and 
diagrams can be produced on the fly. 

Powered by its workspace parameters file architecture and its data-driven graphics philosophy, ArcGIS Schematics 
SDK offers a high degree of flexibility. It is not limited by the evolutions of the data model and by changing database 
locations.  

Included with the ArcGIS Schematics SDK components is ArcGIS Schematics Designer, a graphical user interface 
(GUI)-based design tool that supports configuration and customization of ArcGIS Schematics SDK. 

Also included with ArcGIS Schematics SDK is a set of standard schematic layout algorithms ready to use with network 
data. ArcGIS Schematics SDK can be customized to support user-specific layout algorithms.  

The following screenshots are a set of example schematic views that can be generated using ArcGIS Schematics 
SDK. 

Through an example personal database, this tutorial guide allows you to rapidly get acquainted with the ArcGIS 
Schematics SDK, visualize the database information, and use some of the powerful ArcGIS Schematics SDK layout 
tools to generate various schematic representations of the network data. 

Using your own definition and connection scheme (i.e., its own workspace parameters ".ini" file built with ArcGIS 
Schematics Designer), you can quickly connect to your database from within the integrated ArcGIS Schematics SDK. 
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��Installing ArcGIS Schematics SDK 
Installation of ArcGIS Schematics SDK will create all of the necessary references to the ArcGIS Schematics SDK 
components.  

The template ".ini" file (C:\Schematics_SDK\Samples\WorkspaceExample\Session\Workspace_Example.ini, by 
default) will also be created in the installation process. This workspace parameter file has been designed with ArcGIS 
Schematics Designer and may be tested through the ArcGIS Schematics SDK, such as any ArcGIS Schematics 
workspace parameters file. This example template file shows different sets of behaviors, connection schemes, and 
customization choices for the production of schematic network diagrams. 

��About the DBExample database  
The Workspace_Example workspace parameters file has been designed to graphically display the network data 
described in the DBExample.mdb personal database. The installation process may have copied this database in the 
C:\Schematics_SDK\Samples\WorkspaceExample\Database\DBExample.mdb folder (default location). 

This personal database is composed of four tables: 

o "Feeder" table, which has the following 3 fields: 
- OBJECTID: feeder identifier (Integer) 
- X: feeder X-coordinate value (Double) 
- Y: feeder Y-coordinate value (Double) 

o "Station" table, which has the following 6 fields: 
- OBJECTID: station identifier (Integer) 
- Feeder: feeder identifier the station belongs to (Integer) 
- X: station X-coordinate value (Double) 
- Y: station Y-coordinate value (Double) 
- NodeType: station type (a variable coded as "A", "B", "C", "D", "E", or "F") 
- NodeSize: station size (Double) 

o "HV_Links" table, which has the following 7 fields: 
- OBJECTID: HV_Link identifier (Integer) 
- FromNodeType: node type the link origin node is connected to (String) 
- FromNodeOID: link origin node identifier (Integer) 
- ToNodeType: node type the link end node is connected to (String) 
- ToNodeOID: link end node identifier (Integer) 
- GeoLength: geographical link length (Double) 
- ListPoints: list of link point coordinates that compose the link path 

o "LV_Links" table, which has the following 9 fields: 
- OBJECTID: LV_Link identifier (Integer) 
- FromNodeType: node type the link origin node is connected to (String) 
- FromNodeOID: link origin node identifier (Integer) 
- ToNodeType: node type the link end node is connected to (String) 
- ToNodeOID: link end node identifier (Integer) 
- LinkRate: ratio value associated with the LV_link (Double) 
- LinkType: link type, a variable coded as "S", "M", or "B" (String) 
- GeoLength: geographical link length (Double) 
- ListPoints: list of link point coordinates that compose the link path 

��Opening the Workspace—Example Session 
Launch NgDeveloper.exe (by default, C:\Schematics_SDK\Bin\NgDeveloper.exe). 

Click the File menu and click Open Schematic Session. Choose the " 
C:\Schematics_SDK\Samples\WorkspaceExample\Session\Workspace_Example.ini" workspace parameters file. This 
will create all of the necessary session data to view and manipulate the network data stored in the "DBExample" 
personal database. 

The Workspace_Example parameters file manages two types of documents: 

- MainNet contains the complete network stored in the database. 
- FeederNet allows the display of data related to a single given part of the network (i.e., related to a given 
feeder). 
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��Opening a Schematic Document 
The Workspace_Example parameters file manages two types of documents: 

- MainNet contains the complete network stored in the database. 
- The second type of document allows you to display data related to a single given part of the network (i.e., 
related to a given feeder). 

To open a schematic document, click the Document menu and click Open Document Form. The default Select 
document to open ArcGIS Schematics SDK dialog box opens. 

Choose one of the two document types available from the Document Type dropdown list and select the desired 
document name from the Document name dropdown list. Next, select one of the Tile Views tools from the toolbar to 
arrange your schematic window and click the Fit All button to fit all the schematic objects displayed in the currently 
opened view. 
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Finally, use the ArcGIS Schematics SDK layout tools from the toolbar to arrange your network layout. 

��Saving a Schematic Document 
If your document is saved by using the Save Document command, the position of the nodes and links from the 
network layout as displayed are retained in the GraphicFolder directory in the ArcGIS Schematics SDK graphic 
database format. This database is independent from the applicative database (i.e., independent from the DBExample 
database, here). When a saved document is reopened, the graphic database is synchronized with the application’s 
database, and the modifications (objects created or removed) introduced in the latter are then reflected. 

��Quick Start Summary 
1. Launch the ArcGIS Schematics SDK (NgDeveloper.exe). 

2. Click the File menu and click Schematic Session. Click 
C:\Schematics_SDK\Samples\WorkspaceExample\Session\Workspace_Example.ini. 

3. Open one of the predefined schematic documents managed by the opened workspace parameter file. 

4. Increase the symbol sizes as required and select the desired layout types. 

5. If you want to store your current network layout, save your document before closing it. If not, your 
document will be reopened with the default coordinates (those stored in the DBExample database); all 
changes introduced in the document since it was created (node and link positions) will not be taken into 
account.

About ArcGIS Schematics SDK toolbars 
Press F1 while moving your mouse on any ArcGIS Schematics SDK menu to open the Using ArcGIS Schematics SDK 
2.2 Toolbars online Help: the corresponding ArcGIS Schematics SDK command help page will automatically load. 
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Introducing ArcGIS Schematics Designer 

��ArcGIS Schematics Designer Overview 
ArcGIS Schematics Designer is an essential component of the ArcGIS Schematics product line. 

With this valuable and user friendly modelization interface, you will be able to: 

>> Create a schematic workspace parameters file to: 

- bring back graphic objects stored in the database, 
- create properties to represent them graphically, 
- define the document type in which they will be displayed, 
- specify the application behaviors... 

>> Edit and update any schematic workspace parameters file created in previous versions 

>> Test instantly your schematic workspace parameters file: any change is automatically taken 
into account and can be graphically visualized. 
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��ArcGIS Schematics Designer Menus 
• The "File" menu allows you to access the main session management commands: 

- "Open Schematic Session", to open a new schematic session 

- "Close Schematic Session", to close the currently open schematic session 

_____________________________________________________________________

- "Print View", to print the currently active schematic view window content 

_____________________________________________________________________

- "Remove objects", to delete the selected graphic objects 

- "Copy to Clipboard", to copy the selected graphic objects to the Clipboard 

_____________________________________________________________________

- "Zoom In Mode", to enable the "standard zoom in" mode 

- "Zoom Out Mode", to enable the "standard zoom out" mode 

- "Logical Zoom In Mode", to enable the "logical zoom in" mode 

- "Logical Zoom Out Mode", to enable the "logical zoom out" mode 

_____________________________________________________________________

- "Fit Selected Set", to fit all the selected set graphic objects into the active view 

- "Fit All Graphic Objects", to fit all visible objects into the active view 

- "Pan Mode", to enable the pan mode 

- "Repaint", to refresh the objects in the active view 

_____________________________________________________________________

- "Quit", to close ArcGIS Schematics Designer. If your current workspace’s parameters file has been 
modified without being saved, you will be asked to save it. 

• The "Workspace" menu allows you to access the three following workspace commands: 

- "New Workspace", to create a new workspace (i.e., for creating a new workspace parameters file)  

- "Edit Workspace", to edit the workspace parameters associated with the active schematic session 

- "Save Workspace", to save the currently open workspace parameters file 

• The "Document" menu includes all the documents and views management commands: 

- "Open Document Form", to open a document 

- "New View", to open a new view for the active document 

- "Refresh Document", to update the currently open document 

_____________________________________________________________________

- "Show/Hide Legend", to turn legend display on or off for the active document 

_____________________________________________________________________

- "Cascade Views", to arrange all open schematic view windows as overlapping tiles 

- "Tile Views Horizontally", to arrange all open schematic view windows as nonoverlapping 
horizontal tiles 

- "Tile Views Vertically", to arrange all open schematic view windows as nonoverlapping vertical 
tiles 
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The "Edit" menu allows you to access text or symbol attribute modification commands, graphic 
object alignment commands, and copy and delete commands: 

- "Selection Mode", to enable the "Selection" mode 

- "Edit/Move Mode", to enable the "Select and Move" mode 

_____________________________________________________________________

- "Align Horizontally", to align the selected nodes horizontally 

- "Align Vertically", to align the selected nodes vertically 

_____________________________________________________________________

- "No Mirroring", to cancel the symmetry effects applied to the currently active view 

- "Y Axis Mirroring", to vertically mirror the objects in the currently active view 

- "X Axis Mirroring", to horizontally mirror the objects in the currently active view 

- "XY Axis Mirroring", to vertically and horizontally mirror the objects in the currently active view 

_____________________________________________________________________

- "Increase Text Sizes", to enlarge text sizes 

- "Decrease Text Sizes", to decrease text sizes 

- "Increase Symbol Sizes", to enlarge symbol sizes 

- "Decrease Symbol Sizes", to decrease symbol sizes 

_____________________________________________________________________

- "Select Hierarchy", to select a hierarchy of objects starting from a parent node 

_____________________________________________________________________

- "Open Create Object Form", to enable the digitize mode for graphic object creation 

• The "Algorithms" menu allows you to access the functions for running smart graph layout 
algorithms: 

- "Collapse Hierarchy", to collapse objects hierarchically, from a given node 

- "Collapse Selected Set", to collapse a selected set of ArcGIS Schematics graphic objects 

- "Expand by Level", to expand a set of collapsed nodes by one-level increments 

- "Expand All", to expand a selected collapse root node level-wise 

_____________________________________________________________________

- "Bypass Nodes", to reposition the links in a selected set so as to prevent them from crossing 
nodes 

- "Remove Link Points", to remove all link points from selected links 

_____________________________________________________________________

- "Find Loops", to find existing loops for the graph in the active view 

- "Find Shortest Path", to find the shortest path route between two selected nodes in the active 
schematic view 

- "Find Tree", to find the tree associated with the selected node in the active schematic view 

- "Remove Algorithms Graphic Effects", to remove all highlighting effects from the loops, path, or 
tree found by an algorithm 

_____________________________________________________________________
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- "Orthogonal Layout", to lay out the nodes and links orthogonally in the active schematic view 

- "Hierarchical Layout", to lay out the nodes and links hierarchically in the active schematic view 

- "Backbone Layout", to lay out the loops around a chosen backbone geometry in the active 
schematic view 

_____________________________________________________________________

- "Separate Nodes", to separate nodes that are visually very close or near to overlapping in the 
active schematic view 

- "Grid Layout", to lay out the nodes so they snap onto an active magnetic grid in the active 
schematic view 

- "Rotate Tree", to rotate the tree associated with the node selected in the active schematic view 

_____________________________________________________________________

- "Open Algo Parameters Form", to open the Algorithms Parameters dialog box 
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��ArcGIS Schematics Designer "Standard" Toolbar 
Main Commands 

 "Open Schematic Session" button 

 "Close Schematic Session" button 

______________________________

 "Print View" button 

______________________________

 "Remove objects" button 

 "Copy to Clipboard" button 

______________________________

 "Zoom In Mode" button 

 "Zoom Out Mode" button 

 "Logical Zoom In Mode" button 

 "Logical Zoom Out Mode" button 

______________________________

 "Fit Selected Set" button 

 "Fit All Graphic Objects" button 

 "Pan Mode" button 

 "Repaint" button 

______________________________

Workspace Commands 

 "Create a new workspace" button 

 "Edit the current workspace" button 

 "Save the workspace on disk" button 

______________________________

Document and View Commands 

 "Open Document Form" button 

 "New View" button 

 "Refresh Document" button 
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______________________________

 "Show/Hide Legend" button 

______________________________

 "Cascade Views" button 

 "Tile Views Horizontally" button 

 "Tile Views Vertically" button 



Using ArcGIS Schematics Designer  11 

��ArcGIS Schematics Designer "Tools" Toolbar 
Selecting and Editing Commands 

 "Selection Mode" button 

 "Edit/Move Mode" button 

 "Move Labels Mode" button 

______________________________

 "Align Horizontally" button 

 "Align Vertically" button 

______________________________

 "No Mirroring" button 

 "Y Axis Mirroring" button 

 "X Axis Mirroring" button 

 "XY Axis Mirroring" button 

______________________________

 "Increase Text Sizes" button 

 "Decrease Text Sizes" button 

 "Increase Symbol Sizes" button 

 "Decrease Symbol Sizes" button 

______________________________

 "Select Hierarchy" button 

______________________________

 "Open Create Object Form" button 

Algorithm Commands 

 "Collapse Hierarchy" button 

 "Collapse Selected Set" button 

 "Expand by Level" button 

 "Expand All" button 

______________________________

 "Bypass Nodes" button 
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 "Remove Link Points" button 

______________________________

 "Find Loops" button 

 "Find Shortest Path" button 

 "Find Tree" button 

  "Remove Algorithms Graphic Effects" button 

______________________________

 "Orthogonal Layout" button 

 "Hierarchical Layout" button 

 "Backbone Layout" button 

______________________________

 "Separate Nodes" button 

 "Grid Layout" button 

 "Rotate Tree" button 

______________________________

 "Open Algo Parameters Form" button 
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ArcGIS Schematics Designer Main Concepts 

What Is a Workspace? 

The workspace is the core object in your schematic application. It acts as the central point where access is 
gained to other objects in the system. The workspace provides access to the schematic components your 
application manages as data sources, document types, graphic types, etc. 

A workspace and its associated characteristics can be created and defined through ArcGIS Schematics 
Designer or by Visual Basic® (VB) programming. 

What Is a Document Type? 

A network is made up of nodes and links. These nodes and links are displayed in different generic 
structures called "documents". A document is a collection of schematic views and is related to a single 
workspace. 

A document type is a document model, and it brings together a set of documents that have common 
characteristics. A document type can inherit from another document type. 

To define a document type, you typically declare: 
- Its name 
- Eventually, the name of its parent document type 

You can complete your document definition by defining: 
- The query returning all the documents of this type 
- The fields used to build up each document identifier for this document type 
- One or more attributes associated with this document type 

 A document type and its characteristics can be created and defined through ArcGIS Schematics Designer 
or by VB programming. 

What Is a Graphic Object Type? 

A graphic object type brings together a set of graphic objects that have common characteristics. A graphic 
object type can inherit from another graphic object type. 
When you define a graphic object type, you typically declare:  

- The name of this graphic object type 
- The class of the graphic objects (node, link, drawing) 
- Eventually, the name of its parent graphic object type 

You can complete your graphic object type definition by defining: 
- The query returning all the graphic objects of this type 
- The fields used to build up each graphic object identifier for this type 
- One or more attributes associated with this graphic object type 
- One or more properties associated with this graphic object type 
- One or more “user-datasets” associated with this graphic object type 

A graphic type and its characteristics can be created and defined through ArcGIS Schematics Designer or 
by VB programming. 
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What Is a Group? 
A graphic group is a set of graphic objects that have the same graphic effects. A group is associated with 
a graphic type. Properties that have an impact on the graphic representation of a network are defined as 
groups. 

When you create a new graphic type, you have to decide if your new graphic object type will be associated 
with a graphic group or not. Even if you can redefine graphic types as a group at any time, this decision is 
important. It determines what you will later be authorized to define for your graphic type: when your 
graphic type is a group, you can define any graphic effects, and you can create any property on it. If your 
graphic type is not a group, it is impossible! 

By default, if a graphic type inherits from another graphic type, and if it is not a group, it inherits the 
graphic effects and the properties defined for the first of its ancestor graphic object types, which is a group 
itself. 

What Is a Node? 
A node is a vertex in a network graph. It is represented by a symbol and may be assigned various graphic 
(color, fill style, etc.), geometric (scaling, rotation, etc.) or visual (visibility, highlighting, etc.) attributes. 

Nodes can have geographic, semi-geographic, or graph coordinates. The coordinate system is 
independent of the graphic display window. Several nodes may be aligned along the same horizontal or 
vertical axis. 

If the network is thickly populated, several nodes may be compacted into a single compaction node.  

Two nodes can have a binding—logical and hierarchical—relationship, which means that certain rules will
apply when these nodes are manipulated (e.g., moving or deleting a parent node will cause the associated 
child node to be moved or deleted accordingly). 

What Is a Link? 
A link is an edge in a network graph. A link can go through a number of "link points" that modify its path. It 
is represented either by a direct single line segment or by several line segments passing through one or 
several link points. The path between two link points may be graphically broken. 

All types of patterns may be drawn up along a link path that may also have any given line style (dot, dash, 
etc.) and width. 

A link can have a direction: arrows placed on its start and end points show this. 

If a link path goes through one or several nodes, it can be modified so as to allow the nodes to be 
automatically bypassed. 

What Is a Drawing? 
Drawings are used to introduce additional graphic or text information relating to the network being 
represented: title block, frames, messages, and graphic scenery. 

A drawing can be a basic (line, rectangle, circle, polygon, and text) or a complex graphic object made up 
of several basic graphic objects. 

A drawing is created using a CGM-compliant graphic file. 
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What Is a Property? 
Properties are used to define the characteristics of a group of objects that have an impact in the graphic 
representation of a network. The overall state a network is in is determined by the values taken by the 
existing set of properties at a given time. 

A property is associated with a single group. 

Any property can be represented by a label displayed either directly on the objects it applies to or inside a 
flag associated with these objects. The position of the text is determined either relatively to the objects 
(above/below, for links) or by a port number (for nodes or flags). 

A property created for the sole purpose of displaying a label on an object or inside the flag associated with 
it is said to be "textual". 

To associate graphic effects with a property, the possible values of the property must first be specified. If 
these values belong to a finite set of numbers or of alphanumeric codes, the property is said to be 
"discrete". If the values are simply numeric and indifferent (i.e., they belong to a range of values), the 
property is said to be "bounded".  

To assign specific graphic effects to that property, a filter must be defined for each of its possible values. 
Along with the textual, discrete, and bounded properties, a fourth property—the "direct" property—is also 
available for directly applying a given graphic effect depending on the values taken up by the property 
itself (e.g., scale factor, symbology, etc.). 

The use of properties depends on whether or not its related graphic type is associated with a group. In 
fact, properties must only be created on a group. For a graphic type that is not a group, you can use 
properties defined on its ancestors (if they exist) in order to graphically highlight characteristics, but you 
cannot define new properties for such a graphic type. 

So, for a graphic type that is a group, the "Create Property" menu lets you create any property, but for 
a graphic type that is not a group, you must use the "Associate property" menu that only lets you 
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associate a property defined for one of the ancestor graphic types with an existing attribute. 

What Is a Property Filter? 
A discrete filter refers to a specific value of a property. It can be assigned a name that may be displayed 
on its related objects.  

One or several graphic effects matching the property value can be specified for each filter. The graphic 
effects thus defined apply to all the network objects that are then assigned this property value. In the 
following example, all the links in the network whose "Road Type" property value is equal to "IS" will be 
represented by a red dotted line. 

A bounded filter corresponds to a range of values a property can take. Besides specifying the lower and 
higher bounds of the value range, the filter can be assigned a name that can be displayed on the object it 
is related to. 

One or several graphic effects matching the range of values defined for the property can be specified for 
each filter. The graphic effects thus defined apply to all the network objects that are then assigned a value 
within the corresponding value range. In the following example, all the links in the network whose "Traffic" 
property value is equal to "125" will be represented by a pattern composed of two red circles. 

What Is a Flag Model? 
A flag model is a generic object used to generate flags that will be placed automatically on network 
objects. 

Each flag model contains the symbol used to represent a given flag, plus automatic placement—angle and 
translation—attributes. 
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To create a flag for an object, all you need to do is identify the flag model you want to use. 

What Is a Flag? 
A flag is a graphic object attached to a network object and containing labels associated with that object.  

A flag is automatically inserted on, and attached to, an object according to the rules defined in the model it 
is based on. You can create your own flag models. 

A flag can be associated with any kind of network graphic object (node, link, and drawing). To insert a flag 
on several objects, you must associate its base model with the corresponding object group. 

Different flags based on different models can be associated with the very same object. 

When an object is moved, its associated flag is automatically moved. However, moving a flag does not 
move the object but causes its connecting pole to be redrawn. 

What Is a Pattern Model? 
A pattern is a symbol that is repeated one or several times along a link path route. 

The pattern is drawn on the link according to the rules defined in the model it is based on. 

There are three types of pattern styles: continuous, discrete, and origin/endpoint patterns; directed 
patterns follow the link direction, going from its origin point to its endpoint. 

What Is a Behavior? 
When you define a behavior you specify how the application will respond to end user action on one of the 
application objects (i.e., following an event on one such object). 
A behavior brings together four elements: 

- EventName: an event name (action by end user)  
- TypeName: an object type name 
- MetaType: a metatype of objects  
- Command: a command (response from the application) 

which reads: such event (LeftClick, RightClick, etc.) on such object type of such metatype will trigger such 
command. 

Some definitions:

• EventName: It is the name of an event to be responded to. Possible event names depend on the 
object MetaType. This event name can be a user event name or a predefined ArcGIS Schematics 
Designer event name. For more details about ArcGIS Schematics Designer predefined event 
names, see "List of ArcGIS Schematics Designer predefined event- 
names" Help page.
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• MetaType: It is the object Metatype to be impacted as Document, View, Graphic, LegendGroup, 
LegendProperty, or LegendPropertyFilter. 
. The Document metatype encompasses all documents of the application, whatever their type. 
. The View metatype encompasses all of the views created by the application (a document 
includes one or several views). 
. The Graphic metatype encompasses all graphic objects defined in the application whatever their 
graphic class (Node, Link, Drawing). 
. The LegendGroup encompasses legend entries associated with object groups. 
. The LegendProperty encompasses legend entries associated with properties. 
. The PropertyFilter encompasses legend entries associated with property filters. 

• TypeName: It is the identifier for the graphic object type, used to filter command triggering. The 
object type must be defined for the currently open workspace. If the command is to apply to all 
object types of the MetaType metatype, this identifier is not required. If the metatype is equal to 
View, the TypeName parameter is set to the name of the document type associated with the 
views. This document type must be defined for the currently open workspace. 

• Command: It is the ArcGIS Schematics Designer command to be triggered. This command must 
be defined for the currently open workspace. ArcGIS Schematics Designer offers a full set of 
predefined commands, each with its own area of action, which means that it will apply to a given 
metatype only. 
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ArcGIS Schematics Designer Example 

��Introduction to the ArcGIS Schematics Designer Example 

To exemplify ArcGIS Schematics Designer main concepts and functionalities, we are going to build an 
example based on the database described below: 

> About the database used 

The ArcGIS Schematics Designer example is exemplified with a database composed of four tables: 

o "Nodes" table, with the following six fields: 
- IdNode: node identifier (string) 
- SizeN: node size (number) 
- Type: node type (a variable coded as "A", "B", "C", "D", "E", or "F") 
- SubNet: name of the subnet the node belongs to (a variable coded as "subnet1" or 
"subnet2") 
- X: coordinate value (number) of the X node 
- Y: coordinate value (number) of the Y node 

o "Links" table, with the following six fields: 
- IdLink: link identifier (string) 
- IdNode1: link origin node identifier (string) 
- IdNode2: link end node identifier (string) 
- Rate: ratio value associated with the link (number) 
- Type: link type (a variable coded as "small", "medium", or "big") 
- Length: link length (number) 

o "NewLinks" table, with the following three fields: 
- IdNewLink: link identifier (string) 
- OrigNode: identifier of the link origin node (string) 
- ExtrNode: identifier of the link end node (string) 

o "SubNet" table, with the single following field: 
- IDSubNet: subnet identifier (a discrete variable coded as "subnet1" or "subnet2" [string]). 

> Description of the sample workspace parameters we will build 

We want to graphically display the network data described in this database. The "Links" and "NewLinks" 
tables list all the links of the network. The "Nodes" table concerns all the nodes. And the "SubNet" table 
contains the available subnets the data describes. 

We want to build two types of documents: 

- One will contain the complete network 
and

- The other will allow us to display data related to a single given part of the network (i.e., related to a 
given subnet). 
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> Main Steps Description 

(1) Creating Schematic Documents 

Step 1: Creating the Workspace 

Step 2: Defining the Workspace Parameters 

Step 3: Defining Your Data Source 

Step 4: Creating Your First Document Type 

Step 5: Creating Your First Node Graphic Type 

Step 6: Defining Your First Association 

Step 7: Creating Your First Link Graphic Type 

Step 8: Creating Mandatory Attributes for the Link Graphic Type 

Step 9: Associating the New Link Type and Displaying Your Network 

(2) Animating Schematic Documents 

Step 10: Creating Textual Properties to Display Node and Link Identifiers 

Step 11: Using a Composed CGM Symbol to Display the Node Group 

Step 12: Animating the Network Nodes According to the Node’s "Type" Database Field 

Step 13: Animating the Network Links According to the Link’s "Type" Database Field 

Step 14: Animating the Network Nodes According to the Node’s "SizeN" Database Field 

Step 15: Creating a Flag Model and Using it to Modify the "NodeName" Property Display 

Step 16: Creating Pattern Models That Will be Used Afterwards to Represent a New Link Property 

Step 17: Using Pattern Models to Highlight the Links According to the "Rate" Database Field 

Step 18: Creating a New Document Type for the Different Subnetworks 

Step 19: Creating a New Node Type to Filter Out Nodes According to Their Subnetworks 

Step 20: Creating a New Link Type to Filter Out the Links According to Their Subnetworks 

Step 21: Redefining the Inherited "NodeName" and "LinkName" Properties Displayed on the 
Subnetwork Documents 

Step 22: Using Database Coordinates to Display Your Nodes 

(3) Defining Behaviors 

Step 23: Defining the Behaviors That Will Impact the Views 

Step 24: Redefining the Default "LeftDblClick" Behavior Impacting a Legend Property Filter Entry 

Step 25: Defining the Behaviors That Will Impact Graphic Object Types 
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��Step 1: Creating the Workspace 

Open ArcGIS Schematics Designer:      

Click the "Workspace" menu and click "New Workspace" as follows: 

The predefined "Save As" Microsoft Windows dialog box automatically opens. Select the folder in which 
your workspace parameters file are to be saved, enter a name for your workspace file, and validate: 
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The ArcGIS Schematics Designer Editor window appears as follows: 
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��Step 2: Defining the Workspace Parameters 
When a new workspace is created, the ArcGIS Schematics Designer Editor window appears as: 
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- Defining the Default Symbol for Flag Models

Clicking anywhere on the "Default Flag Symbol" field displays the  button: 

Click this button to launch the CGM symbol editor and vector drawing tool (NgUSymbolEditor). 
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Use the NgUSymbolEditor drawing tools to build your CGM symbol as you wish. Select the "Save As..." 
item from the "File" menu, enter the name that will reference your first subsymbol, then exit the 
NgUSymbolEditor: 

The "Default Flag Symbol" field is automatically completed by the name of the symbol you have created. 
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- Defining the Default Symbol for Nodes 

Click the Default Node Symbol field and click this button  to launch the CGM symbol editor and vector 
drawing tool (NgUSymbolEditor): 
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Use the NgUSymbolEditor drawing tools to build your CGM symbol as you wish. Enter a name for the 
current symbol and exit the NgUSymbolEditor: 

The "Default Node Symbol" field is automatically completed by the name of the symbol you have just 
created. 
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- Defining the Workspace Default Scaling Factor

Click the "Default Scaling" field and enter a value: 
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- Defining the Workspace Line Color Effects

Click the "Effects" tab and click anywhere in the "Line Color" field to display a color box: 
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Click the color box to launch the Table Colors Editor. Select or define a color and validate: 
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- Defining the Workspace Line Width Effects

Click the "Line Width" field and modify the default line width value with the one you want: 
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Click the "Text Color" parameter field to display a color box and click it to launch the Table Colors Editor if 
you want to change the text color default value: 
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��Step 3: Defining Your Data Source 

Right-click the "Data Sources" tree entry and click "Add Data Source" from the popup menu: 

The "New Data Source" dialog box automatically opens. Enter a name in the "Name" field to reference 
your data source: 
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Click the "Edit Connection" button to open the UDL Editor Microsoft component. In the "Provider" tab, 
select a provider from the list: 
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From the "Connection" tab, browse your database file, check your connection by clicking the "Test 
Connection" button, and validate: 
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The new data source tree entry is automatically created below the "Data Sources" entry: 
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��Step 4: Creating Your First Document Type 

Right-click the "Document Types" tree entry and click "Create": 

The ArcGIS Schematics Designer "Create Document Type" dialog box opens. Enter the name that will be 
used to reference your first document type and click OK: 
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The new document type tree entry is automatically created below the "Document Types" entry: 

For the first document type, we define no other parameter. 
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��Step 5: Creating Your First Node Graphic Type 

Right-click the "Graphic Types" tree entry and click "Create": 

The ArcGIS Schematics Designer "Create Graphic Type" dialog box opens. Enter the name that will be 
used to reference your first node graphic type. 

In the "Graphic Class" field, click "Node" from the dropdown list, and click OK: 
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The new node graphic type tree entry is automatically created below the "Graphic Types" entry. 

The preview window shows the symbol that will be used by default to represent all nodes of this type. 
Here, it is the workspace’s default node symbol:  
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-Defining "Data" Parameters

(1) Select the data source name from the "Data Source" dropdown list. Here, we selected the single data 
source name existing: "NgMainDataSource". 
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(2) Click the "Query" parameter field, then click the  button: 
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(3) The ArcGIS Schematics Designer "Query Editor" automatically opens. In our example, as the nodes 
query will be related to the "Nodes" table, we select the table called "Nodes" from the "Tables" list: 
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(4) Next, we automatically define our query clicking the "All Records" button: the current graphic type 
concerns all the nodes in the database: 
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(5) Click OK to validate these parameters. The just defined query is automatically displayed in the "Query" 
parameter field: 
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(6) Click the "Identifier" parameter field and click the  button: 
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(7) The ArcGIS Schematics Designer "Identifier Editor" automatically opens. Select the fields that will be 
used to identify the graphic objects of this type: as the "IdNode" field is the primary key in the "Nodes" 
table, we select this field to identify each node of this type. 

Note: All the objects related to a graphic object type must be identifiable as a unique graphic object. 
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(8) Validate the selected fields by clicking the  button, then click OK: 
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(9) The just defined identifier is automatically displayed in the "Identifier" field parameter: 



50  Using ArcGIS Schematics Designer 

��Step 6: Defining Your First Association 

Right-click the document type tree entry (in our example it is "MyMainDocumentType") and click "Create 
Association" from the popup menu as follows: 

The ArcGIS Schematics Designer "Create Association" dialog box automatically opens. Select the 
"MyNodes" already defined graphic type name and click OK: 
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The "Associations" and the first associated graphic type "MyNodes" tree entries are automatically created 
below the currently selected document type: 
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��Testing and Displaying Your First Network 

At the end of the sixth step, you should have defined all the primary elements necessary to graphically 
display your first schematic document and its content. In fact, you have defined: 

- A workspace and its primary parameters 
- One document type: "MyMainDocumentType". As you have declared no query for this document 
type, it is automatically related to one single document 

and
- One graphic node type: "MyNodes". For this graphic type, you have defined a query that returns 
all the nodes stored in the database. 

When declaring the association between the document type and the graphic node type, you have 
defined the main elements for your workspace’s first component: a document containing all the nodes 
stored in the database and... you can display it! 

1) Click the "Save" button, , at the bottom right corner of the ArcGIS Schematics Designer 
Editor window, to save all of your already defined parameters. 

2) Use the "Close" button, , to close the ArcGIS Schematics Designer Editor window. 

3) Now click the "Open Document Form" icon on the ArcGIS Schematics Designer toolbar, 

or select "Open Document Form" from the "Document" menu. 

4) The "Select document to open" predefined dialog box opens: 

The only document type called "MyMainDocumentType" is available from the "Document type" dropdown 
list, and the single  "MyMainDocumentType" document is available from the "Document name" dropdown 
list.
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Select this document and click OK. Your first schematic document opens as follows: 

Note that as no geometric attributes are defined for any nodes (i.e., x and y coordinates are not specified 
for each node), ArcGIS Schematics Designer automatically places the nodes on a default grid. 
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�� Step 7: Creating Your First Link Graphic Type 
Right-click the "Graphic Types" tree entry and click "Create": 

The ArcGIS Schematics Designer "Create Graphic Type" dialog box opens. Enter a name that will be used 
to reference your first link graphic type. Select "Link" from the "Graphic Class" dropdown list and click OK: 
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The new link graphic type tree entry is automatically created below the "Graphic Types" entry. 

The preview window shows the link appearance for the links of this type. Here, as no specific values are 
specified for the line color and line width fields, it is the workspace’s default parameter values set for lines 
that are used:  
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- Defining "Data" Parameters

(1) Select a data source name from the "Data Source" dropdown list. Here, we selected the existing single 
data source name: "NgMainDataSource". 

Click the "Query" parameter field and click the  button: 
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(2) The ArcGIS Schematics Designer "Query Editor" automatically opens. Here, in our example, as the 
links query will be related to the "Links" table, we select the table called "Links" from the "Tables" list: 
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(3) Next, we automatically define our query clicking the "All Records" button: the current graphic type 
concerns all the links in the database: 
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(4) Click OK to validate these parameters. The just defined query is automatically displayed in the "Query" 
parameter field. 

Now click the "Identifier" parameter field and click the  button: 
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(5) The ArcGIS Schematics Designer "Identifier Editor" component automatically opens. Select the fields 
that will be used to identify the graphic objects of this type. As the "IdLink" field is the primary key in the 
"Links" table, we select this field to identify each link of this type. 

Note: All the objects related to a graphic object type must be identifiable as a unique graphic object. 

Validate the selected fields by clicking the  button and click OK: 
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(6) The just defined identifier is automatically displayed in the "Identifier" field: 
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��Step 8: Creating Mandatory Attributes for the Link Graphic Type 
Suppose that you want to test the display of your network now: even if you associate your new link type 
with your document type (this step is essential to display your new links), your network will appear as 
follows: 

Even if the links appear in the legend subwindow, they are not displayed. 

In fact, the links display is conditioned by their topological properties: origin and extremity nodes must be 
specified to display a link. 

We need to create the two link’s compulsory attributes: NGG_OriginNode and NGG_ExtremityNode. 

(1) Right-click the "MyLinks" tree entry corresponding to your link type and select the "Create Attribute" 
menu: 

The ArcGIS Schematics Designer "Create Graphic Type Attribute" dialog box automatically opens: select 
the "NGG_OriginNode" predefined attribute name from the "Name" dropdown list and, as the origin node 
is a unique field returned by the link type query, select "Field Attribute" from the "Type" dropdown list and  
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validate: 

An "Attributes" new tree entry is automatically created below the "MyLinks" graphic type tree entry, and 
the "NGG_OriginNode" new attribute itself is referenced below this new entry: 
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(2) Select the "Field Name" parameter field and click the  button to open the ArcGIS Schematics 
Designer "Identifier Editor". 

Select the fields that will be used to identify each link’s origin node. In this example, the "IdNode1" field 
returned by the link type query is the field used to identify the link’s origin. We select it from the "Fields" 

area, click the  button to take our choice into account, and click OK: 
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The "IdNode1" value is automatically displayed in the "Field Name" field: 

(3) Repeat the first and second steps to create the second "NGG_ExtremityNode" mandatory attribute as 
follows: 
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��Step 9: Associating the New Link Type and Displaying Your 
Network 

(1) As already done when you defined the association between your first node type and your single 
document type, right-click the "MyMainDocumentType" tree entry and click "Create Association" from the 
popup menu. 

Note: You can also choose the "Create" menu displayed when you right-click the "Associations" tree entry 
as follows: 

In both cases, the ArcGIS Schematics Designer "Create Association" dialog box opens as follows: 

Select the "MyLinks" value from the "Name" dropdown list and click OK. 
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The just created association is automatically referenced below the "Associations" tree entry:  
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(2) Now that you have defined a document containing all the nodes and the links stored in the database 
you can display the complete network. 

Click Save to save all your workspace parameters and click Close to close the ArcGIS Schematics 
Designer Editor window. 

Click the "Open Document Form" icon on the ArcGIS Schematics Designer toolbar,  or click the "Open 
Document Form" item from the "Document" menu. Select the single "MyMainDocumentType" document 
type name from the "Document Type" dropdown list and click OK. Your new schematic document opens 
as follows: 
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��Step 10: Creating Textual Properties to Display Node and Link 
Identifiers 

In this step, we are going to create two textual properties: 
- The "NodeName" property will display the node name centered at the top of each node. The 
information will be formatted as follows: "Node ID: IdNode" where IdNode corresponds to the "IdNode" 
field returned by the node type query. 

- The "LinkName" property will display the link name in blue, centered below each link, as follows: "From 
node IdNode1 to IdNode2" where IdNode1 and IdNode2 correspond to the "IdNode1" and "IdNode2" fields 
returned by the link type query (i.e., the origin and extremity node identifiers, respectively). 

>> Creating the "NodeName" Property
(1) As the "NodeName" property will use the "IdNode" field returned by the query as a formatted 
parameter of the property label that will be displayed, we must begin with creating an attribute 
corresponding to this field. 

Right-click the "MyNodes" tree entry and select "Create Attribute" from the popup menu: 

In the ArcGIS Schematics Designer "Create Graphic Type Attribute" dialog box, enter the name of the new 
attribute in the "Name" field ("NodeID", for example), select "Field Attribute" value in the "Type" dropdown 
list and validate: 
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The "NodeID" new attribute is automatically referenced below the "Attributes" tree entry related to the 
"MyNodes" graphic type. 

Select the "Field Name" field displayed in the right part of the ArcGIS Schematics Designer Editor window 

and click the  button to open the ArcGIS Schematics Designer "Identifier Editor". Select the "IdNode" 

field from the dialog box’s "Fields" area, click the  button to take the chosen field into account, and 
click OK. The ArcGIS Schematics Designer Editor window appears as follows: 
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(2) The "NodeName" property that we are going to create will not directly use the "NodeID" attribute. The
property label must be formatted as follows: "Node ID: IdNode". We have just created the "NodeID" 
attribute that will correspond to the IdNode label parameter. Now we must create a new attribute to format 
the label as well. 

As in the previous step, right-click the "MyNodes" tree entry and select "Create Attribute" from the popup 
menu (you can also select the "Create" menu by right-clicking the "Attributes" tree entry displayed just 
below the "MyNodes" tree entry).  

In the "Create Graphic Type Attribute" dialog box, enter the name of the second new attribute in the 
"Name" field ("FormattedNodeID", for example), select "Formatted Attribute" value from the "Type" 
dropdown list, and click OK: 

Now, in the right part of the ArcGIS Schematics Designer Editor window corresponding to the 
"FormattedNodeID" new attribute’s parameters, specify the format that will be used to build up the new 
attribute. When you validate the format parameter, ArcGIS Schematics Designer automatically detects that 
one attribute is needed to build the new attribute. So a new parameter field—"Attribute1"—is displayed: 
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From the "Attribute1" dropdown list select the "NodeID" attribute name and click OK: 
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(3) At the end of this step, we have built up the label that we want to display at the top of each node. Now 
we must create the textual property that will manage this information display. 

Right-click the "MyNodes" tree entry and select "Create Property" from the popup menu: 

In the "Create Property" dialog box that opens, set the name of the new property in the "Property Name" 
field. Because the default parameters set in this form ("Textual" property type and "String" value type) are 
those we need, click OK. 

Now, in the right part of the ArcGIS Schematics Designer Editor window corresponding to the 
"NodeName" new textual property’s parameters, specify the attribute name that will be used to display the 
property label: 
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Click the "Effects" tab and select the "BottomCenter" value from the "Text Alignment" dropdown list. 

Note: "BottomCenter" text alignment means that the graphic object will appear centered at the bottom of 
the property label (i.e., the label will be centered at the top of each node). 
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Now set the "Text Size" parameter as follows and click OK: 
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Save your workspace parameters, close the ArcGIS Schematics Designer Editor window, and test your 
network display. The result will be as follows: 

>> Creating the "LinkName" Property
(1) Here, the "LinkName" property will use the "IdNode1" and "IdNode2" fields returned by the query as 
formatted parameters of the property label displayed. We have already defined two attributes 
corresponding to these fields, "NGG_OriginNode" and "NGG_ExtremityNode" attributes. These two 
attributes are those we need to build the property label as we want; we just have to create the 
corresponding formatted attribute. 

As in the node case, right-click the "MyLinks" tree entry and select "Create Attribute" from the popup menu 
(you can also select the "Create" menu by right-clicking the "Attributes" tree entry displayed just below the 
"MyLinks" tree entry).  

In the "Create Graphic Type Attribute" dialog box, enter the name of the new attribute in the "Name" field 
("FormattedLinkID", for example), select "Formatted Attribute" from the "Type" dropdown list, and click OK: 

Now, in the right part of the ArcGIS Schematics Designer Editor window corresponding to the 
"FormattedLinkID" new attribute’s parameters, specify the format that will be used to build up the new 
attribute and validate.  
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From the "Attribute1" and "Attribute2" dropdown lists, select the "NGG_OriginNode" and the 
"NGG_ExtremityNode" attribute names, respectively. 



Using ArcGIS Schematics Designer  79 

(2) At the end of this step, we have built up the label that we want to display below each link. Now we must
create the textual property that will manage this information display. 

Right-click the "MyLinks" tree entry and select "Create Property" from the popup menu. In the "Create 
Property" dialog box that opens, set the name of the new property in the "Property Name" field and click 
OK: 
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Now, in the right part of the ArcGIS Schematics Designer Editor window corresponding to the "LinkName" 
new textual property’s parameters, specify the attribute name that will be used to display the property 
label. 
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Click the "Effects" tab and select the "TopCenter" value from the "Text Alignment" dropdown list. Set the 
"Text Size" parameter value and select the blue color you want by using the ArcGIS Schematics Designer 
Color Editor. (Clicking the little rectangle displayed when you click anywhere in the "Text Color" parameter 
field automatically opens this component): 
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Now click the "Others" tab and select the "Below" value from the "Label Placement" dropdown list: 

Save your workspace parameters, close the ArcGIS Schematics Designer Editor window, and test your 
network display. The result will be as follows: 
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��Step 11: Using a Composed CGM Symbol to Display the Node 
Group 

As the "MyNodes" symbol name is not specified, ArcGIS Schematics Designer uses the default node 
symbol set for the workspace to display each node of this type. 

In this step, to represent the "MyNodes" node type, we decide to create a new symbol based on the 
already existing "MyDefNodeSymbol" CGM symbol and composed of two other subsymbols. 
At the node type level, each subsymbol will be invisible, but we will modify the subsymbols’ visibility 
attribute afterwards when we define graphic effects related to a property filters in Step 12. 

Activate the "MyNodes" tree entry, select the "Symbol Name" parameter displayed in the "General" tab, 

and click the  button to launch the NgUSymbol Editor. 



84  Using ArcGIS Schematics Designer 

(1) Creating the subsymbol CGM files

Use the  button to draw a green rectangle as in the following screenshot. Select the "Save As..." item 
from the "File" menu and enter the name that will reference your first subsymbol: 

Note: Symbols are saved by default in the CGM folder in 
C:\arcgis\arcexe82\Schematics\Samples\VB\Session. 

Next, select the “New” item from the “File” menu to create the new empty CGM file where a second 
subsymbol will be drawn. 
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Use the button to draw an orange rectangle as in the following screenshot. Select the "Save As..." item 
from the "File" menu and type the name that will reference your second subsymbol: 

(2) Creating the node type CGM symbol
Now, we are going to create the node type CGM symbol. Select "New" from the "File" menu. Then, select 
"Import..." from the "File" menu as in the following screenshot: 



86  Using ArcGIS Schematics Designer 

In the "Open" dialog box, select the "MyDefNodeSymbol" CGM file from the "CGM" directory: 

Click "Open". The "Import" dialog box automatically opens. Check the "Import graphics" box and click OK: 

The "MyDefNodeSymbol" CGM circle is automatically imported and placed in the center of the 
NgUSymbol window. 

Now, select "SubSymbol..." from the "Insert" menu: 
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Select the CGM file corresponding to the first subsymbol (the green rectangle) and click OK: 

Repeat the operation to insert the second subsymbol file (the orange rectangle) and save the CGM file 
result. 
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Exit the "NgUSymbolEditor" drawing tool. The just created CGM file is automatically used as the node type 
symbol: 
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(3) Setting the subsymbols attributes to represent the node group
As this CGM symbol is composed of subsymbols, the "SubSymbols" tab lets you show and modify each 

subsymbol attribute. Select this tab and click the  button, which is displayed when you click anywhere 
in the first subsymbol line to edit the subsymbol effects. 
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In the "SubSymbol Effect" form that automatically opens, click the "Others" tab, select "Invisible" from the 
"Visibility" dropdown list, and click OK. Repeat this operation for the second subsymbol. 
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When you are finished this step, the preview subwindow that shows the node appearance should appear 
as follows: 
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��Step 12: Animating the Network Nodes According to the Node’s 
"Type" Database Field 

The "Type" field returned by the node graphic type query stores the type of each node. Each node is either 
an "A", "B", "C","D", "E", or "F" type. 

In this step, we will take this information into account graphically: we are going to create the 
"DisplayNodeType" discrete property composed by six discrete filters; each filter corresponds to each 
"Type" value.  

(1) Creating the "NodeType" Attribute Corresponding to the Node "Type" Field
As the "DisplayNodeType" property will use the "Type" field returned by the query, we must begin to 
create an attribute corresponding to this field. 

Right-click the "Attributes" tree entry displayed below the "MyNodes" graphic type and select the "Create" 
menu: 

In the ArcGIS Schematics Designer "Create Graphic Type Attribute" form:  
 - Set the name that will be used to reference the new attribute in the "Name" field.  
 - Select "Field Attribute" from the "Type" dropdown list and click OK: 
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Fill the "Field Name" parameter by selecting the "Type" field. 

(2) Creating the "DisplayNodeType" Discrete Property
Now you will create the "DisplayNodeType" discrete property that will display each node according to the 
just created "NodeType" attribute value. 

Right-click the "Properties" tree entry displayed below the "MyNodes" graphic type and select the "Create" 
menu:  
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In the "Create Property" form, fill the "Property Name" field the same way as in the following screenshot, 
select "Discrete" as type property, and click OK: 

The new "DisplayNodeType" property is automatically referenced below the "Properties" tree entry. 
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Now associate this new property with the "NodeType" attribute by selecting "NodeType" from the "Attribute 
Name" dropdown list:  
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(3) Creating the "DisplayNodeType" Discrete Filters
A discrete property exists through its discrete filters. So, we are going now to create the 
"DisplayNodeType" discrete filters: 

- Click the  button on the lower right-hand corner of the ArcGIS Schematics 
Designer Editor window. 
- The ArcGIS Schematics Designer "Add a discrete filter" form automatically opens. Fill the "Name" field, 
set the first value that will be associated with this first filter (this value is one of the values taken by the 
"Type" field stored in the database), and click OK: 

The "Filters" tab is automatically displayed. The filter you just created is referenced in this new tab: 
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Repeat this operation to create five new other filters corresponding to the "B", "C", "D", "E", and "F" values 
available from the "Type" field in the database: 
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(4) Defining the Graphic Effects Corresponding to Each Discrete Filter

This discrete property will display the nodes according to the "Type" field as follows: 

"Type" Value Filter Graphic Effects
A The first subsymbol is to be visible 
B The second subsymbol is to be visible 
C The second subsymbol is to be visible, with a rotation angle of 90 degrees, 

and its fill color is to be changed
D The two subsymbols are to be visible 
E A new CGM symbol will be used 
F A character of the ESRI Cartography font will be used 

>> Defining the "Filter A" Discrete Filter Graphic Effects (Activating the "SsSymbol1" Visibility)

- From the "Filters" tab, select the "Type A" first discrete filter and click the   button. 
- The "Filter Effects" form automatically opens. As the node type’s symbol is composed by subsymbols, a 
"SubSymbols" tab is displayed. Select this tab. Its content resumes all the subsymbols that composed the 
node type’s symbol. 

- Select the line corresponding to the first subsymbol and click the   button. 
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- The "SubSymbol Effect" form related to the "SsSymbol1" subsymbol opens. Click the "Others" tab and 
select the "Visible" value from the "Visibility" dropdown list: 

Click OK to close the "SubSymbol Effect" form. The preview subwindow in the "Filter Effects" form 
appears as follows: 
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>> Defining the "Filter B" Discrete Filter Graphic Effects (Activating the "SsSymbol2" Visibility) 

For the "Filter B" discrete filter, you will repeat the same operations with the second subsymbol. 

At the end of this step, the preview subwindow displayed in the "Filter Effects" form should appear as 
follows: 
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>> Defining the "Filter C" Discrete Filter Graphic Effects (Activating the "SsSymbol2" Visibility, 
Changing the Default Subsymbol Rotation Angle, and Modifying the Default Fill Color) 

Open the "Filter Effects" form corresponding to the third discrete filter. Click the "SubSymbols" tab and 
open the "SubSymbol Effect" form related to the "SsSymbol2" subsymbol. 

In the "Others" tab, select "Visible" from the "Visibility" dropdown list and set an angle value in the 
"Rotation" field: 
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Now click the "Effects" tab and change the "Fill Color" value: 

Click OK to close the "SubSymbol Effect" form. The preview subwindow in the "Filter Effects" form 
appears as follows: 
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>> Defining the "Filter D" Discrete Filter Graphic Effects (Activating the Two "SsSymbol1" and 
"SsSymbol2" Visibility) 

For this fourth discrete filter’s graphic effects, modify the "Visibility" parameter related to each subsymbol, 
such as the two subsymbols displayed in the following preview subwindow: 

.
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>> Defining the "Filter E" Discrete Filter Graphic Effects (Creating a New CGM Symbol and This 
New Symbol to Represent the Filter) 

In the "General" tab corresponding to the fifth discrete filter, open the "NgUSymbolEditor" from the 
"Symbol Name" parameter field: 
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Draw a rectangle, save it as NodeTypeESymbol, and exit from the "NgUSymbolEditor": 
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>> Defining the "Filter F" Discrete Filter Graphic Effects (Using a Specific Character Font) 

The symbol used to represent a node or a drawing graphic object is often a CGM symbol. But a specific 
character font can also be used to display that graphic object. 

For the last discrete filter representation, you can represent the node with any character of the "ESRI 
Cartography" font. 

Open the "Filter Effects" form related to this last discrete filter and click the "Effects" tab. Set the "ESRI 
Cartography" font in the "Text Font" field and choose the "Text Color" that will be used to display the 
character: 
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Now click the ’"General" tab and, from the "Symbol Name" parameter field, click the  button to open 
the ArcGIS Schematics "Symbol Browser".  

Select the desired ESRI Cartography TrueType™ character and click OK to validate. 
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The chosen character ASCII code appears in the "Symbol Name" parameter field; it is preceded by the "#" 
character: 
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(5) Testing Your Network Display 

Click Save to save all your workspace parameters and click Close to close the ArcGIS Schematics 
Designer Editor window. Now click the "Open Document Form" icon on the ArcGIS Schematics Designer 
toolbar, or click the "Open Document Form" item from the "Document" menu. Select the single 
"MyMainDocumentType" document type name from the "Document Type" dropdown list and click OK. 
Your document opens as follows: 
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��Step 13: Animating the Network Links According to the Link’s 
"Type" Database Field 

The "Type" field returned by the link graphic type query stores the type of each link. Each link is either a 
"Small", "Medium", or "Big" type. 

In this step, you will decide to take this information into account graphically: we are going to create the 
"DisplayLinkType" discrete property composed by three discrete filters, with each filter corresponding to 
one type value. This property will display the links according to the "Type" field as follows: 

"Type" Value Filter Graphic Effects
Small Width Line: 1.0 
Medium Width Line: 2.0 
Big Width Line: 4.0 

(1) Creating the "LinkType" Attribute Corresponding to the Link "Type" Field
As the "DisplayLinkType" property will use the "Type" field values returned by the query, we must begin by 
creating an attribute corresponding to this field. 

As for nodes, right-click the "Attributes" tree entry displayed below the "MyLinks" graphic type and select 
the "Create" menu from the displayed popup menu; the ArcGIS Schematics Designer "Create Graphic 
Type Attribute" form automatically opens. Set the name that will be used to reference the new attribute in 
the "Name" field, select the "Field Attribute" value from the "Type" dropdown list, and click OK: 
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Fill the "Field Name" parameter by selecting "Type":  
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(2) Creating the "DisplayLinkType" Discrete Property
Now you will create the "DisplayLinkType" discrete property. It will display each link according to the 
"LinkType" attribute value. 

Right-click the "Properties" tree entry displayed below the "MyLinks" graphic type and select the "Create" 
menu from the displayed popup menu. In the "Create Property" form that opens, fill the "Property Name" 
field as in the screenshot below, select "Discrete" as the type property, and click OK: 



Using ArcGIS Schematics Designer  113 

Now associate this new property with the "LinkType" attribute by selecting "LinkType" in the "Attribute 
Name" dropdown list:  
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(3) Creating the "DisplayLinkType" Discrete Filters
Like when you defined the "DisplayNodeType" property for the "MyNodes" graphic type, click the 

 button on the lower-right corner of the ArcGIS Schematics Designer Editor 
window to create the property’s first discrete filter. Fill the "Name" field in the ArcGIS Schematics Designer 
"Add a discrete filter" form, set the value that will be associated with this first filter (this value is one of the 
values taken by the "Type" field stored in database), and click OK: 

Repeat the preceding operation to create two other filters corresponding to the "Medium" and "Big" values 
available from the "Type" field database: 
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(4) Defining the Graphic Effects Corresponding to Each Discrete Filter

>> Defining the "Small Type" Discrete Filter Graphic Effects (Defining the "Line Width" Parameter) 

From the "Filters" tab, select the "Small Type" first discrete filter and click the   button to open the 
"Filter Effects" form. Select the "Effects" tab and set the "Line Width" parameter as follows: 

>> Defining the "Medium Type" and the "Big Type" Discrete Filters Graphic Effects (Defining the 
"Line Width" Parameter) 

Click the   button from the "Medium Type" second discrete filter to open the "Filter Effects" form 
related to this second discrete filter graphic effects. Set the "Line Width" parameter displayed in the 
"Effects" tab with the "2.0" value. 

Repeat this operation for the third discrete filter ("Big Type"). Fill the "Line Width" parameter with the "4.0" 
value. 
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(5) Testing Your Network Display
Use the "Save" button to save all your workspace parameters and click the "Close" button to close the 
ArcGIS Schematics Designer Editor window. Click the "Open Document Form" icon on the ArcGIS 
Schematics Designer toolbar, or click the "Open Document Form" item from the "Document" menu. Select 
the single "MyMainDocumentType" document type name from the "Document Type" dropdown list and 
click OK. Your document opens as follows: 
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��Step 14: Animating the Network Nodes According to the Node’s 
"SizeN" Database Field 

The "SizeN" field returned by the node graphic type query stored the size of each node as an integer 
value.  

In this step, we decide to take this information into account graphically; we will create the 
"DisplayNodeSize" bounded property composed by four bounded filters, with each filter corresponding to 
one range of values. This property will display the nodes according to the "SizeN" field as follows: 

"SizeN" Lower Value "SizeN" Upper Value Filter Graphic Effects
0 2 Scaling Factor: 1.0 
3 5 Scaling Factor: 2.0 
6 8 Scaling Factor: 3.0 
9 10 Scaling Factor: 5.0 

(1) Creating the "NodeSize" Attribute Corresponding to the Node "SizeN" Field
As the "DisplayNodeSize" property will use the "SizeN" field returned by the query, we must begin to 
create an attribute corresponding to this field. 

Right-click the "Attributes" tree entry displayed under the "MyNodes" graphic type and select the "Create" 
menu from the popup menu. 

In the ArcGIS Schematics Designer "Create Graphic Type Attribute" form, set the name that will be used 
to reference the new attribute in the "Name" field and select "Field Attribute" from the "Type" dropdown 
list:
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Next, fill the "Field Name" parameter by selecting "SizeN": 

(2) Creating the "DisplayNodeSize" Bounded Property

Now we are going to create the "DisplayNodeSize" bounded property that will display each node
according to the "NodeSize" attribute value. 

Right-click the "Properties" tree entry displayed under the "MyNodes" graphic type and select the "Create" 
menu to open the "Create Property" form. Fill the "Property Name" field as in the following screenshot, 
select "Bounded" type property, select "Integer" from the "Value Type" dropdown list, and click OK: 

The new "DisplayNodeSize" property is automatically referenced below the "Properties" tree entry. 
Associate this new property with the "NodeSize" attribute by selecting "NodeSize" from the "Attribute 
Name" dropdown list.  
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(3) Creating the "DisplayNodeSize" Bounded Filters

Now click the  button on the lower-right corner of the ArcGIS Schematics 
Designer Editor window. The ArcGIS Schematics Designer "Add a bounded filter" form automatically 
opens. Fill the "Name" field, set the lower and the upper values that will define this first bounded range, 
and click OK: 

Repeat the preceding operation to create three new other filters corresponding to the "3 to 5", "6 to 8", and 
"9 to 10" values ranges. At the end of this step, the "Filters" tab should look like the following graphic: 
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 (4) Defining the Graphic Effects Corresponding to Each Bounded Filter
>> Defining the "Size 1" Bounded Filter Graphic Effects (Defining the "Scaling" Parameter)

From the "Filters" tab, select the "Size 1" first bounded filter and click the   button to open the "Filter 
Effects" form. Select the "Others" tab and fill the "Scaling" parameter with the "1" value, as shown in the 
following graphic: 

Click OK to close the "Filter Effects" form.  

>> Defining the "Size 2", "Size 3", and "Size 4" Bounded Filters Graphic Effects (Defining the 
"Scaling" Parameter) 
For the three other bounded filters, repeat the same operations and fill the "Scaling" parameter with the 
"2", "3", and "5" values, respectively. 
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(5) Testing Your Network Display
Now save all your workspace parameters and click the "Close" button to close the ArcGIS Schematics 
Designer Editor window. Click the "Open Document Form" icon, select the single "MyMainDocumentType" 
document type name from the "Document Type" dropdown list, and click OK. Your document opens as 
follows: 
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��Step 15: Creating a Flag Model and Using it to Modify the 
"NodeName" Property Display 

(1) Creating Your First Flag Model
Right-click the "Flag Models" tree entry displayed below the "Environment" entry and select the "Create" 
menu: 

The ArcGIS Schematics Designer "Flag Model" dialog box opens. Enter the name that will be used to 
reference your first flag model and click OK: 

The new flag model tree entry is automatically created below the "Flag Models" entry. 
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The preview window shows the symbol that will be used by default to represent all flags of this type. The 
workspace’s default flag symbol is in the screenshot below: 

Use one of the two buttons (  or ) displayed when you select the "Symbol Name" field if you want 
to change the CGM symbol. 
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Click the different tabs to set the parameters you want.  
For example, from the "Others" tab, you can set: 

- The distance that will be used to display the flags of this type according to the position of the 
graphic objects with which it will be associated ("Shift Distance" parameter) 

- The angle of the pole that will connect each flag to its associated graphic object ("Angle" 
parameter) 

These are shown in the following graphic: 
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(2) Associating This Flag Model with the "MyNodes" Group
We want to modify the already defined "NodeName" property so that this new flag model is used to display 
the property label. Because no flag can be attached to the objects of a group if no association is set 
between the flag model and this objects group, we must begin to associate the new flag model with our 
"MyNodes" object group. 

From the "MyNodes" graphic type Editor window, click the  button displayed in 
the right-bottom corner to open the "Add Flag" form. Choose the single "FlagModel1" already defined and 
click OK to automatically associate the new flag model with the nodes group: 
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The "FlagModels" tab is created. The preview subwindow shows the new node appearance with its flag: 

From this new "FlagModels" tab, select the "FlagModel1" flag model line and click the   button to open 
the "Pole Effect" form. This form must be used to specify  the graphic attributes of the pole that connects 
each flag to its associated object. For example, from the "Effects" tab, modify the "Line Color" and the 
"Line Width" as follows so that the pole line displays in blue and its width is enlarged: 
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(3) Modifying the "NodeName" Property Parameters
As the new flag model is now associated with the node group, we will modify the "NodeName" property 
parameters so that the property label is displayed in the flag. 

Click the "NodeName" property tree entry and in the "General" tab, select the "FlagModel1" flag model 
from the "Display Flag Model" dropdown list.  

Save your workspace parameters and test your network display. 
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If the flag size is not suited to the label length, you can modify the "XScaling" and "YScaling" flag model 
parameters, as shown in the following screenshot:  

At the end of this step, your network should appear as follows: 
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��Step 16: Creating Pattern Models That Will Be Used Afterwards 
to Represent a New Link Property 

In this step, you will create two pattern models that you will then use to display the links according to a 
new property value. 

(1) Creating a Pattern Model Symbol
The first "PatternSymbol1" pattern model we will create is a pattern model symbol that will display an 
arrow placed on the middle of each link path route. 
Right-click the "Pattern Models" tree entry displayed under the "Environment" entry and select the 
"Create" menu: 

The ArcGIS Schematics Designer "Pattern Model" dialog box opens. Enter the name that will be used to 
reference your first pattern model, select the "Pattern Symbol" value from the "Type" dropdown list, and 
click OK. 

The new pattern model tree entry is automatically referenced below the "Pattern Models" tree entry. 
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From the "General" tab, specify the CGM symbol that will represent each pattern; use the  button 
displayed when you select the "Symbol Name" field to launch the NgUSymbolEditor and draw the new 
CGM file representing the desired symbol. 
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The parameters needed to define the rules that will be used to repeat the patterns along the segment are 
those available in the pattern model "Others" tab. 

Select this tab. The default values set for the "Positioning Mode", the "Shift Distance", the "Spacing", and 
the "Max Items On Segment" parameters are those we need to display a pattern on the middle of each link 
path route; our first pattern model definition is finished. 
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(2) Creating a Pattern Model Text
The second "PatternText1" pattern model we will create is a pattern model text that will display the "K" 
character along each link path route. The pattern color should automatically change according to the color 
of the link on which it will be displayed. The rules to repeat the pattern along the segment are as follows: 

- Spacing between items: 5.0 

- First item is 3.0 units away from link origin 

As when you created your first pattern model, select the "Create" menu displayed when you right-click the 
"Pattern Models" tree entry to open the ArcGIS Schematics Designer "Pattern Model" dialog box. Enter 
the name that will be used to reference your second pattern model, select the "Pattern Text" value from 
the "Type" dropdown list, and click OK: 
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Select the new pattern model tree entry displayed below the "Pattern Models" tree entry and set the "K" 
character in the "Pattern Text" parameter field displayed in the "General" tab as in the following 
screenshot: 
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Next, click the "Others" tab to define the rules that will be used to repeat the patterns along the segment. 
Select the "AbsoluteSpacing" value from the "Positioning Mode" dropdown list. Set the "Shift Distance" 
value that will be used to display the first pattern item. 

Set the "Spacing" value that will be used to space each pattern item on the link. 

Select the "Slave" value from the "Color Mode" dropdown list so that the pattern color automatically 
changes according to the link color: 

The second pattern model definition is finished. Save your workspace parameters. 
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��Step 17: Using Pattern Models to Highlight the Links According 
to the "Rate" Database Field 

The "Rate" field returned by the link graphic type query stores the rate of each link as a double value.  

In this step, we decide to take this information into account graphically; we are going to create the 
"DisplayLinkRate" bounded property composed by five bounded filters, with each filter corresponding to 
one range of values. This property will display the links according to the "Rate" field as follows: 

"Rate" Lower 
Value

"Rate" Upper 
Value

Filter Graphic Effects

0 200 000 Use the "PatternSymbol1" pattern model 
200 000 400 000 Use the "PatternText1" pattern model 
400 000 600 000 Use the "PatternSymbol1" and "PatternText1" pattern model 
600 000 800 000 Display the link in blue 
800 000 1 000 000 Display the link in red with the dashed dotted line style 

(1) Creating the "LinkRate" Attribute Corresponding to the Link "Rate" Field
As the "DisplayLinkRate" property will use the "Rate" field returned by the query, we must begin to create 
an attribute corresponding to this field. 

Right-click the "Attributes" tree entry displayed under the "MyLinks" graphic type and select the "Create" 
menu from the displayed popup menu to open the ArcGIS Schematics Designer "Create Graphic Type 
Attribute" form. Set the name that will be used to reference the new attribute in the "Name" field, select the 
"Field Attribute" value from the "Type" dropdown list, and click OK: 



136  Using ArcGIS Schematics Designer 

Fill the "Field Name" parameter by selecting the "Rate" field: 
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(2) Creating the "DisplayLinkRate" Bounded Property
Now you are going to create the "DisplayLinkRate" bounded property. This will display each link according 
to the "LinkRate" attribute value. 

Right-click the "Properties" tree entry displayed under the "MyLinks" graphic type and select the "Create" 
menu from the displayed popup menu. In the "Create Property" form that opens, fill the "Property Name" 
field as in the following screenshot, select "Bounded" as type property, select "Double" from the "Value 
Type" dropdown list, and click OK: 
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Now associate this new property with the "LinkRate" attribute by selecting "LinkRate" from the "Attribute 
Name" dropdown list:  
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 (3) Creating the "DisplayLinkRate" Bounded Filters

Click the  button on the lower-right corner of the ArcGIS Schematics Designer 
Editor window to create the property’s first bounded filter. Fill the "Name" field in the ArcGIS Schematics 
Designer "Add a bounded filter" form and set the value that will be associated with this first filter (this value 
is one of the value taken by the "Type" field stored in the database). Click OK: 

Repeat the preceding operation to create four other filters that correspond to the value ranges specified 
above. 
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(4) Defining the Graphic Effects Corresponding to Each Bounded Filter
>> Defining the "Rate 1", "Rate 2", and "Rate 3" Bounded Filters Graphic Effects (Use the 
"PatternSymbol1" or/and the "PatternText1" Pattern Models to Display the Links)

From the "Filters" tab, select the "Rate 1" first bounded filter and click the   button to open the "Filter 

Effects" form. Click the  button in the right-bottom corner to open the "Add Pattern 
Model" form, and select the desired pattern model from the "Name" dropdown list: 

The "Pattern Model" tab is created. It shows the pattern models that have been added to represent the 
link. 
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Repeat the same operation for the "Rate 2" and "Rate 3" bounded filter. For the "Rate 3" bounded filter, 
the "Pattern Model" should appear as it does in the following graphic: 
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>> Defining the "Rate 4" and "Rate 5" Bounded Filters Graphic Effects (Setting the "Line Color" 
and/or the "Line Style" Parameter)

Click the   button from the "Rate" second discrete filter to open the "Filter Effects" form related to the 
desired discrete filter graphic effects. Set the "Line Color" parameter displayed in the "Effects" tab. 
Repeat this operation for the "Rate 5" bounded filter and, for this last filter, specify the "Line Style", too: 
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(5) Testing Your Network Display
Now save all your workspace parameters and click the "Close" button to close the ArcGIS Schematics 
Designer Editor window. Click the "Open Document Form" icon, select the single "MyMainDocumentType" 
document type name from the "Document Type" dropdown list, and click OK. Your document opens as 
follows: 
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��Step 18: Creating a New Document Type for the Different 
Subnetworks 

The "SubNet" field stored in the "Nodes" table can be used to filter out the graphic objects according to the 
subnetwork to which they belong. It can be a good idea to create a new type of document whose 
associated documents will correspond to each subnetwork stored in the database. 

(1) Creating the "MySubDocumentType" New Document Type  
Right-click the "Document Types" tree entry and select the "Create" menu. It automatically opens the 
ArcGIS Schematics Designer "Create Document Type" form. 

Fill the "Name" text box. Even if the "MyMainDocumentType" has no particular characteristics, it can be 
interesting that this new document inherits from the first one; in fact, if we decide to create specific 
behaviors for the parent document type, these behaviors will be automatically inherited at the child level. 
So, from the "Parent Name" dropdown list, select the single existing document type as follows: 
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(2) Defining the "MySubDocumentType" Data Source and Query

As this new document type must filter out the graphic objects that will be associated with it according to 
the subnetwork these objects belong to, each subnetwork in the database builds a single document of this 
type: the query that will return all the documents of this type should return the distinct occurrences of the 
subnetworks stored in the database. 

Select the "NgMainDataSource" from the "Data Source" dropdown list: 
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Click the  button displayed when you select the "Query" field to open the ArcGIS Schematics Designer 
"Query Editor". Select the table called "Nodes" from the "Tables" list, and write the query that will return all 
the subnetworks stored in the database. Use the "Show Results" button to test your query and click OK to 
close the "Query Editor" form: 
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(3) Defining the "MySubDocumentType" Identifier
Now you must specify the name that will be used to reference each document of this type. The "SubNet" 

field returned by the query can be used to identify each document; click the   button displayed when 
you select the "Identifier" field to open the ArcGIS Schematics Designer "Identifier Editor" and use the 

 button to select this field:  
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(4) Creating Attributes  
When such a document type is created to filter out graphic objects stored in the database, we must define 
the document type attribute that will later be used to filter the objects associated with a selected document 
in this document type. That way these graphic objects will be automatically associated with each 
document of this type. In this case, it is the "SubNet" field that we will need. 

Right-click the "MySubDocumentType" entry and select the "Create Attribute" menu to open the ArcGIS 
Schematics Designer "Create Document Type Attribute" form: 

.

Fill the "Name" dropdown list, select "Field Attribute" value from the "Type" dropdown list, and click OK: 
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Next, fill the "Field Name" parameter by selecting the "SubNet" field: 
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��Step 19: Creating a New Node Type to Filter Out Nodes 
According to Their Subnetworks 

In this step, we will create the new graphic type node that will be used to filter out all the nodes stored in 
the database according to the subnetwork to which they belong. 

(1) Creating the "SubNodes" New Node Type  
Right-click the "Graphic Types" tree entry and select the "Create" menu that automatically opens the 
ArcGIS Schematics Designer "Create Graphic Type" dialog box. Fill the "Name" text box and select the 
"Node" graphic class. 

Because it will be interesting to carry all the properties created for the already defined "MyNodes" node 
type over to the new node type, we can: 

- Select the "MyNodes" type from the "Parent Name" dropdown list 
and

- Check off the "Graphic Group" option so that this report becomes automatic. 
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(2) Associating the New Node Type with the New Document Type
Even if the new node type definition is not finished, it is often useful to associate the new graphic type at 
this step of its creation. In fact, in the following step, when we define the query related to these nodes, we 
will need to filter these nodes according to the document chosen (i.e., if the chosen document is 
"SubNet1", the application has to automatically filter the nodes belonging to this "SubNet1" subnetwork, 
etc.) The "SubNetFilter" attribute we have created for the "MySubDocumentType" will be necessary for the 
node type query definition. 

Right-click the "MySubDocumentType" entry and select the "Create Association" menu that automatically 
opens the ArcGIS Schematics Designer "Create Association" dialog box: 

From the "Name" dropdown list, select the new "SubNodes" graphic type and click OK: 
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(3) Redefining the New Node Type Query
As the new node type inherits from the "MyNodes" graphic type, the default query set for this new graphic 
object type is the "MyNodes" query. This query must be redefined so that it returns the nodes related to 
one subnetwork only. 

From the "Query" parameter field displayed in the "General" tab related to the new node type, click the 

 button to open the "Query Editor" window. 

Write in the "Query" area the query that will return all the nodes related to a given document (i.e., related 
to one subnetwork); this query is parameterized. The parameter must correspond to the chosen document 
(i.e., to the document’s "SubNetFilter" attribute value). 

As the node type is already associated with the "MySubDocumentType", this attribute is available from the 
Parameters Name dropdown list:  



Using ArcGIS Schematics Designer  153 

(4) Redefining the New Nodes Identifier
Due to the inheritance, the node identifier is "MyNodes" by default. This identifier can be redefined: for 
example, as shown in the following graphic, you can build up the node identifiers by concatenating the 
document name and the node identifier stored in the database so that each node graphic object has a 
unique identifier: 
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(5) Testing the Subnetworks Display
The new node type definition is finished. Click the "Save" button to save all your new workspace 
parameters and click the "Close" button to close the ArcGIS Schematics Designer Editor window. Now 
click the "Open Document Form" icon on the ArcGIS Schematics Designer toolbar, or click "Open 
Document Form" from the "Document" menu. Select the "MySubDocumentType" document type name 
from the "Document Type" dropdown list. Choose the desired document name from the "Document Name" 
dropdown list and validate. Your new schematic document opens as follows: 

Note #1: The document names available from the "Document Name" dropdown list are those returned by 
the document type query. 

Note #2: The new node type inherits from the "MyNodes" type, so all properties defined for the parent 
node type are automatically reported on the child node type. As the query set for the new node type 
returns the same parent fields needed by these inherited properties, the properties representation is 
effective. 
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��Step 20: Creating a New Link Type to Filter Out the Links 
According to Their Subnetworks 

In this step you will create a new graphic type link that will be used to filter out all the links stored in the 
database according to the subnetwork to which they belong. 

(1) Creating the "SubLinks" New Link Type  
Right-click the "Graphic Types" tree entry and select the "Create" menu that automatically opens the 
ArcGIS Schematics Designer "Create Graphic Type" dialog box. 

Fill the "Name" text box and select the "Link" graphic class. As for the "SubNodes" node type, we decide 
that this new link type inherits from "MyLinks". Check the "Graphic Group" option so that the inheritance is 
complete: 



156  Using ArcGIS Schematics Designer 

(2) Associating the New Link Type with the New Document Type
As for the node type, we are now going to associate the new link type with the "MySubDocumentType" 
document type so that the "SubNetFilter" attribute we have created for the "MySubDocumentType" will be 
available for the link type query definition. 

Right-click the "MySubDocumentType" entry and select the "Create Association" menu that automatically 
opens the ArcGIS Schematics Designer "Create Association" dialog box: 

From the "Name" dropdown list, select the new "SubLinks" graphic type and click OK: 
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(3) Redefining the New Link Type Query

From the "Query" parameter field displayed in the "General" tab related to the new link type, click the 
button to modify the default inherited query set for this graphic type. The "Query Editor" window 
automatically opens. 

Write the query that will return all the links related to a given document (i.e., related to one subnetwork) in 
the "Query" area. The "SubNodes" query is parameterized, and the parameter must correspond to the 
chosen document (i.e., to the document’s "SubNetFilter" attribute value): 
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(4) Redefining the New Link Identifiers
The default inherited identifier can be redefined: for example, as shown in the following screenshot, we 
can build up the link identifiers by concatenating the document name and the link identifier stored in the 
database so that each link graphic object has a unique identifier: 
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(5) Creating the "NGG_OriginNode" and "NGG_ExtremityNode" Link’s Mandatory Attributes
A link can be displayed only when NGO core knows which origin and extremity node the link connects. 
The node identifiers have been redefined: each "SubNodes" node is identified by concatenating their 
subnetwork and their database identifier. 

So, even if the NGG_OriginNode and NGG_ExtremityNode attributes defined for the "MyLinks" parent link 
type are automatically inherited at the "SubLinks" level, they must be redefined at the child level.  

Right-click the "MyLinks" tree entry corresponding to your link type and select the "Create Attribute" menu: 

From the ArcGIS Schematics Designer "Create Graphic Type Attribute" dialog box, choose the 
"NGG_OriginNode" predefined attribute name from the "Name" dropdown list, select "Field Attribute" from 
the "Type" dropdown list, and click OK: 

An "Attributes" new tree entry is automatically created below the "SubLinks" graphic type tree entry, and 
the "NGG_OriginNode" new attribute itself is referenced under this new entry. From the "Field Names" 

parameter, click the  button to open the ArcGIS Schematics Designer "Identifier Editor". Select the 
fields that will be used to identify each link’s origin node. Here, the "SubNet" and "IdNode1" fields returned 
by the link type query are the fields used to identify the link origin. 
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Repeat this operation to create the second "NGG_ExtremityNode" mandatory attribute obtained by 
concatenating the "SubNet" and "IdNode2" fields returned by the link type query. 
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(6) Testing the Subnetworks Display
The new link type definition is finished. Click the "Save" button to save all your new workspace parameters 
and click the "Close" button to close the ArcGIS Schematics Designer Editor window. Click the "Open 
Document Form" icon on the ArcGIS Schematics Designer toolbar, or click "Open Document Form" from 
the "Document" menu. Select the "MySubDocumentType" document type name from the "Document 
Type" dropdown list. Select the desired document name from the "Document Name" dropdown list and 
validate. Your new schematic document opens as follows: 
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��Step 21: Redefining the Inherited "NodeName" and "LinkName" 
Properties Displayed on the Subnetwork Documents 

Due to the inheritance, the "NodeName" and "LinkName" properties defined for the "MyNodes" and 
"MyLinks" graphic type are automatically reported on the "SubNodes" and "SubLinks" graphic type. 
Inherited properties can be redefined at the child level. 
In this step, we will redefine these property labels as follows: 

- In the subnetwork document, the "NodeName" property will only display the "IdNode" field stored 
in the database. 

- In the subnetwork document, the "LinkName" property will display the link name as follows: 
"IdLink: OriginNode-ExtremityNode". 

>> Redefining the "NodeName" Property
The "NodeID" attribute field defined for the "MyNodes" graphic type corresponds to the "IdNode" field 
stored in the database. 

As the "SubNodes" graphic type inherits from the "MyNodes" one, this attribute is automatically inherited 
at the child level. 

At the "MyNodes" graphic type level, the "NodeName" property is associated with the "FormattedID" 
attribute. In the subnetwork document, we want to associate this inherited property with the inherited 
"NodeID" attribute. 

For the "SubNodes" graphic type, the "NodeName" property redefining only consists in the reassociating 
of this inherited property with the inherited "NodeID" attribute. 
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Right-click the "SubNodes" entry and select the "Associate Property" menu to open the ArcGIS 
Schematics Designer "Associate Property" dialog box: 

Select the inherited "NodeName" property from the "Name" dropdown list, select the "NodeID" attribute 
among all the inherited attributes available from the "Attribute" dropdown list, and click OK: 
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Save your new workspace parameters and test one of the subnetwork document displays: 
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>> Redefining the "LinkName" Property

At the "MyLinks" graphic type level, the "LinkName" property is associated with the "FormattedLinkID" 
attribute. In the subnetwork document, we want to change the inherited property label so that this property 
displays a formatted label built as follows: "IdLink: OriginNode-ExtremityNode". 

We must start by creating a new formatted attribute at the "SubLinks" level to build this new label. 
Right-click the "Attributes" tree entry displayed below the "SubLinks" entry and select the "Create" menu: 

When the "Create Graphic Type Attribute" form opens, enter a name in the "Name" field and select 
"Formatted Attribute" from the "Type" dropdown list: 
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Next, define the new attribute’s format and select the three attributes that will be used to build this attribute 
from the "Attribute1", "Attribute2", and "Attribute3" dropdown list. Note that all the inherited attributes from 
the "MyLinks" graphic type are available in these three attribute dropdown lists. 

Now the "LinkName" property redefining only consists of the reassociating of this inherited property with 
the new "NewLinkNameLabel" attribute defined at the "SubLinks" level. 
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Right-click the "SubLinks" entry and select the "Associate Property" menu to open the ArcGIS Schematics 
Designer "Associate Property" dialog box: 
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Select the inherited "LinkName" property from the "Name" dropdown list, select the "NewLinkNameLabel" 
attribute among all the attributes available from the "Attribute" dropdown list, and validate. 

Note that the "Attribute" dropdown list lists all the inherited attributes from the "MyLinks" graphic type as 
well as the single "FormattedLinkID" attribute we have just defined at the "SubLinks" level. 

Save your new workspace parameters and test one of the subnetwork document displays: 
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��Step 22: Using Database Coordinates to Display Your Nodes 
Until now, because no coordinates have been specified for nodes, our graphic objects are automatically 
placed on a grid. 

In this step, we will use nodes x,y coordinates stored in the database to display nodes. 
These coordinates can be automatically taken into account if we define two new specific attributes on the 
node graphic type: the "NGG_InitialXPosition" and "NGG_InitialYPosition" predefined attributes. 

In this example, we will define these attributes at the "SubNodes" graphic type level. So, the nodes 
displayed in the "MyMainDocumentType" document will be displayed without their database coordinates, 
and the nodes displayed in a subnetwork document will be positioned with their real coordinates. 

(1) Right-click the "Attributes" tree entry displayed under the "SubNodes" entry and select the "Create" 
menu to open the "Create Graphic Type Attribute" form: 
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(2) Select the predefined "NGG_InitialXPosition" attribute name from the "Name" dropdown list. As the x 
coordinates are clearly stored in a single field in the database, select "Field Attribute" from the "Type" 
dropdown list and validate: 

(3) From the new attribute "General" tab, click the  button displayed in the "Field Name" field to open 
the ArcGIS Schematics Designer "Identifier Editor". 
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Next, select the "X" field returned by the "SubNodes" query. This field stores each node X-coordinate: 

Repeat these three steps to create the "NGG_InitialYPosition" attribute that will be used to display the 
nodes according to their Y-coordinates.  
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Save your workspace parameters and test one of your subnetworks view displays: 
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��Step 23: Defining the Behaviors That Will Impact the Views 
Let’s now go one step further in the application design process by defining the application behaviors. 

In this Help page, we will define a behavior impacting any view when it is right-clicked. 

Generally, the main useful commands needed from a view are as follows: 
- Turning the legend subwindow display on/off  

- Fitting all the graphic objects in the view 

- Repositioning the graphic objects displayed in the view according to their last saved position 

We are going to create a behavior that will display a popup menu for launching these three commands. 

(1) Right-click the "View Types Behaviors" tree entry displayed under the "Behaviors" main entry and 
select the "Create" menu to open the "Create Behavior" form: 
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Select the "RightClick" predefined event name from the "EventName" dropdown list. As the "Create 
Behavior" form has been opened from the "View Types Behaviors" tree entry, the "MetaType" dropdown 
list is already filled with the "View" value: 

(2) Now, from the new behavior "General" tab, select "NGGCommandPopupMenu" from the "Command" 
dropdown list as follows: 
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Click the "Command" tab and define the command that will correspond to the first popup menu item: 

- Set the first item name that will appear in the popup menu 
and

- Select "NGGCommandLegend" from the "Command1" dropdown list 

The first item definition is finished; selecting this item will allow you to turn the legend subwindow on and 
off depending on if it is already displayed or not. 
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(3) Next, click the  button to create the second popup menu item and define its 
related parameters as follows: 

- Set the second item name that will appear in the popup menu 
and

- Select "NGGCommandFitAll" from the "Command2" dropdown list 

The second item definition is finished; selecting this item will allow all the graphic objects displayed to fit in 
any view: 
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(4) Click the  button to create the third popup menu item and define its related 
parameters as follows: 

- Set the third item name that will appear in the popup menu 
and

- Select "NGGCommandInitialPosition" from the "Command3" dropdown list 

As this command is parameterized, click the  button that automatically appears on the right of the 
"Command3" field to display its associated "CurrentCommand" tab: 
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Select this tab and define the "ModeSet" and "ModeNotSet" parameter values as follows: 

- For the "ModeSet" parameter, select the "DB" value from the dropdown list so that all graphic objects 
positioned with the "NGG_InitialXPosition" and "NGG_InitialYPosition" attributes are restored in their 
database positions. 

- For the "ModeNotSet" parameter, select the "Nothing" value from the dropdown list so that graphic 
objects that do not contain "NGG_InitialXPosition" and "NGG_InitialYPosition" attributes are not moved. 
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(5) Save your workspace parameters, close the ArcGIS Schematics Designer Editor window, and test your 
popup menu display:  

Note: The "Initial Positions" item has a different impact when it is called from a view associated to the 
"MyMainDocumentType" or from a subnetwork view. In the first case, graphic objects are not repositioned. 
In the second case, their database coordinates are restored. 
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��Step 24: Redefining the Default "LeftDblClick" Behavior 
Impacting a Legend Property Filter Entry 

When your workspace was created, ArcGIS Schematics Designer automatically created some behaviors. 

For the legend property filter, the "LeftDblClick" behavior allows you to automatically select the graphics 
objects associated with the property filter. 

In this example, we will modify this behavior so that it chains the automatic selection of the graphics 
objects associated with the property filter and the centering of these objects in the view. 

Because the "NGGCommantFit" command, which centers the graphic objects selected set in a view, can 
only be triggered from a view, you will have to delegate the selection from the legend property filter to the 
view. Two steps are necessary to define the new behavior: 

1) Defining a user-event on the view that triggers the fitting of a graphic objects selected set  

2) Modifying the "LeftDblClick" behavior already defined on the legend property filter so that it chains the 
selection of the associated graphic objects and the fitting of these objects in the view. 

(1) Defining the "Fitting" User-Event

Right-click the "View Types Behaviors" tree entry displayed below the "Behaviors" main entry and select 
the "Create" menu to open the "Create Behavior" form. 

Set the user-event name that will be used to reference this behavior in the "EventName" zone and 
validate: 
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Now from the new behavior "General" tab, select "NGGCommandFit" from the "Command" dropdown list 
as follows: 

As this command is not parameterized, the first step is finished. 
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(2) Redefining the "LefDblClick" Behavior Impacting Legend Property Filters

Select the "LeftDblClick" behavior entry displayed below the "Property Filter Behaviors" tree entry. 

From the "General" tab, modify the "Command" parameter by selecting "NGGCommandContainer" from 
the dropdown list. (Note: The NGGCommandContainer is the command used to chain several 
commands.) 
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Click the "Command" tab. From the "Command1" dropdown list, select the 
"NGGCommandOnLegendEntry". 

Click the  button that automatically appears on the right of the "Command1" field to display its 
associated "CurrentCommand" tab: 
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Click the "CurrentCommand" tab that lets you specify the current "NGGCommandOnLegendEntry" 
parameters. Keep the default parameters and click the "Command" tab. 
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Click the  button to create the second command we want to chain with the first 
one. Select "NGGCommandDelegate" from the "Command2" dropdown list: 
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Click the  button that automatically appears on the right of the "Command2" field to display its 
associated "CurrentCommand" tab and select this tab. 

As we want to delegate the behavior from the legend property filter to the view, select "View" from the 
"MetaType" dropdown list. Next, select the "Fitting" newly created user-event name from the "EventName" 
dropdown list: 

This "LeftDblClick" behavior definition is now finished. Save your workspace parameters, close the 
window, and test your new behavior. 
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��Step 25: Defining the Behaviors That Will Impact Graphic Object 
Types 

In this step we will create behaviors that will impact the "MyNodes" and "MyLinks" graphic types when an 
object of this type is right-clicked. 

For example, for the "MyNodes" type, this behavior can display a popup menu that allows you to: 

1. Rotate all the nodes by 45 degrees. 
2. Center the clicked node in the view. 
3. Activate or deactivate the "DisplayNodeType" property graphic effects. 
4. Activate or deactivate the "DisplayNodeSize" property graphic effects. 

If the first, third, and fourth popup menu items correspond to a single parameterized command, the second 
one must chain several commands. In fact, the command used to center an object in a view works on a 
selected object only. As right-clicking a node doesn’t select it, we will have to select the node before 
centering it. 

The "NGGCommandContainer" used to chain several commands cannot be directly called from a popup 
menu item. The solution consists of defining a user-event to trigger this command chaining that we will call 
from the popup menu item through a "NGGCommandDelegate" command. 

For the "MyLinks" type, we can also display a popup menu that allows you to:  

1. Activate or deactivate the "LinkName" property label. 
2. Activate or deactivate the "DisplayLinkType" property graphic effects. 
3. Activate or deactivate the "DisplayLinkRate" property graphic effects. 
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>> Defining the Sample Behavior Related to the Node Types

(1) Defining the "CenterNode" User-Event

Right-click the "Behaviors" tree entry and select the "Create" menu to open the "Create Behavior" form: 

Set the user-event name that will be used to reference this behavior in the "EventName" zone, select 
"Graphic" from the "MetaType" dropdown list, choose the "MyNodes" graphic type, and validate: 



Using ArcGIS Schematics Designer  189 

Now, from the new behavior "General" tab, select "NGGCommandContainer" from the "Command" 
dropdown list as follows: 
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Next, click the "Command" tab. From the "Command1" dropdown list, select 
"NGGCommandSelectObject": 
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Click the  button to create the second command that will chain with the first one. 
Select  "NGGCommandCenterObject" from the "Command2" dropdown list: 
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As shown in the following screenshot, this user-event definition can end by calling the 
"NGGCommandUnselectAll" command so that object just selected is automatically unselected after it is 
centered in the view: 
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(2) Defining the "RightClick" Behavior Impacting the "MyNodes" Graphic Objects
Right-click the "Behaviors" tree entry and select the "Create" menu to open the "Create Behavior" form: 

Select “RightClick” from the "EventName" dropdown list, select "Graphic" from the "MetaType" dropdown 
list, choose the "MyNodes" graphic type, and validate. 

Now, from the new behavior "General" tab, select "NGGCommandPopupMenu" from the "Command" 
dropdown list as follows: 
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Click the "Command" tab and start defining the command that will correspond to the first popup menu item 
parameter: 

- Set the first item name that will appear in the popup menu 
and

- Select the "NGGCommandRotate" from the "Command1" dropdown list:  
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Click the  button that automatically appears on the right of the "Command1" field to display its 
associated "CurrentCommand" tab. Select this tab and specify the "Parameter" value that corresponds to 
the angle that will be used to rotate the nodes: 
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Select the "Command" tab and click the  button to set the second popup menu 
item parameters: 

- Set the second item name that will appear in the popup menu 
and

- Select the "NGGCommandDelegate" from the "Command2" dropdown list: 
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Click the  button on the right of the "Command2" field to display its associated "CurrentCommand" tab 
and select this tab. 

The "MetaType" parameter default value is the right one. We just have to set the "EventName" parameter 
value; select the "CenterNode" behavior from the dropdown list: 
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Select the "Command" tab and click the  button to set the third popup menu item 
parameters: 

- Set the third item name that will appear in the popup menu 
and

- Select the "NGGCommandTogglePropertyState" from the "Command3" dropdown list: 
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Click the  button on the right of the "Command3" field to display its associated "CurrentCommand" tab 
and select this tab. 

Select "Enabled" from the "Status" dropdown list so that the property graphic effects are turned on/off 
according to the property current status. Select "MyNodes" from the "GraphicType1" and select the related 
property, "DisplayNodeSize": 
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Select the "Command" tab and click the  button to set the last popup menu item 
parameters: 

- Set the item name that will appear in the popup menu 
and

- Select the "NGGCommandTogglePropertyState" from the "Command4" dropdown list: 
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Click the  button on the right of the "Command4" field to display its associated "CurrentCommand" tab 
and select this tab. 

Select "Enabled" from the "Status" dropdown list, select "MyNodes" from the "GraphicType1" field, and 
select the related property—"DisplayNodeType": 

This behavior definition is now finished. Save your workspace parameters, close the window, and test the 
behavior. 

Note that if this behavior is defined for the "MyNodes" type, it is also available for the inherited 
"SubNodes" type. 
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>> Defining the Sample Behavior Related to the Link Types

As for the nodes, right-click the "Graphic Types Behaviors" tree entry and select the "Create" menu to 
open the "Create Behavior" form. 

Select "RightClick" from the form’s "EventName" dropdown list, select the "MyLinks" graphic type, and 
validate: 
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From the new behavior "General" tab, select "NGGCommandPopupMenu" from the "Command" 
dropdown list as follows: 
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Click the "Command" tab to start defining the command that will correspond to the first popup menu item: 

- Set the first item name that will appear in the popup menu 
and

- Select "NGGCommandTogglePropertyState" from the "Command1" dropdown list: 
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Now click the   button on the right of the "Command1" field to display its associated 
"CurrentCommand" tab and select this tab. 

Select "PropertyValue" from the "Label Display Mode" dropdown list so that the property label is turned 
on/off according to the property current status. Select "MyLinks" from the "GraphicType1" field and select 
the related property—"LinkName": 
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Select the "Command" tab and click the  button to set the second popup menu 
item parameters: 

- Set the second item name that will appear in the popup menu 
and

- Select "NGGCommandTogglePropertyState" from the "Command2" dropdown list: 
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Click the   button on the right of the "Command2" field to display its associated "CurrentCommand" 
tab and select this tab. 

Select "Enabled" from the "Status" dropdown list so that the property graphic effects are turned on/off 
according to the property current status. Select "MyLinks" from the "GraphicType1" field and select the 
related property—"DisplayLinkType": 

Select the "Command" tab and click the  button to create the last popup menu 
item parameters. This item must turn the graphic effects related to the "DisplayLinkRate" property on and 
off according to its current state. The definition is similar to the second item you just created.  
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